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Návod na prácu s mračnom bodov v aplikácii QGIS 

 

Mračno bodov predstavuje množinu priestorových bodov popisujúcich povrch terénu a objektov na 
ňom, ktoré sú výsledkom merania pomocou leteckého alebo pozemného laserového skenovania.  
Súbory mračien bodov z leteckého laserového skenovania poskytované Geodetickým 
a kartografickým ústavom Bratislava sú dostupné bezodplatne a je ich možné stiahnuť priamo 
z aplikácie MAPKA alebo získať na základe objednávky vo formátoch LAS alebo LAZ v súradnicových 
systémoch: 

▪ S-JTSK[JTSK03] (kód EPSG:8353) s výškami v Baltskom výškovom systéme po vyrovnaní [Bpv] 
(kód EPSG:8357) 

▪ ETRS89-TM34 (kód EPSG:3046) s výškami hETS89 (elipsoidická výška v systéme ETRS89  
nad elipsoidom GRS80) 

Viac informácií nájdete na Geoportáli.  

V aplikácii QGIS je možné pracovať s mračnom bodov od verzie 3.20. QGIS je možné bezodplatne 

stiahnuť na stránke https://www.qgis.org/en/site/forusers/download.html. Všetky vydané verzie 

QGIS je možné stiahnuť na stránke https://qgis.org/downloads/. Návod bol aktualizovaný pre 

verziu 3.38.1 (19.7.2024). 

Upozornenie: Názvy priečinkov a súborov, ktoré sa v budú v aplikácii používať, by mali byť 
pomenované bez diakritiky a medzier, pretože niektoré nástroje s tým môžu mať problém. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://zbgis.skgeodesy.sk/mapka/sk/teren/export?
https://www.geoportal.sk/sk/zbgis/lls/poskytovanie/
https://www.geoportal.sk/sk/zbgis/lls/
https://www.qgis.org/en/site/forusers/download.html
https://qgis.org/downloads/
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1. Pridanie do projektu a nastavenie súradnicového systému 
 

Aplikácia QGIS umožňuje pracovať s mračnami bodov vo formátoch LAS, LAZ, Etwine Point Clouds 

(ETP.JSON), COPC Points Clouds (COPC.LAZ) alebo Virtual Point Cloud (VPC). Pre pridanie súborov 

s mračnami bodov do projektu treba v hlavnom menu kliknúť na panel Layer → Add Layer → Add 

Point Cloud Layer: 

 
 
Otvorí sa okno Data Source Manager | Point Cloud, kde v časti Source Type označiť File a v časti Point 

cloud dataset(s) vybrať súbor s mračnom bodov a potom kliknúť na tlačidlo Add: 
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Následné sa do panelu Layers pridá vrstva s mračnom bodov a zobrazí v mapovom okne: 

 
 
Po pridaní vrstvy mračna bodov do projektu skontrolovať nastavený súradnicový systém. V paneli 

Layers kliknúť pravým tlačidlom myši na vrstvu a vybrať Properties a tam v časti Source je uvedený 

súradnicový systém vrstvy. Ak sa v políčku Assigned Coordinate Reference System (CRS) nezobrazuje 

správny súradnicový systém, tak pre jeho nastavenie kliknúť na tlačidlo Select CRS , po čom sa 

otvorí okno Coordinate Reference System Selector, kde v hornom políčku vybrať možnosť Predefined 

CRS. Následne súradnicový systém vybrať zo zoznamu súradnicových systémov v časti Coordinate 

Reference System alebo jednoducho vyhľadať po zadaní jeho EPSG do políčka Filter. Vyhľadaný 

súradnicový systém sa zobrazí v okne Coordinate Reference System, kde ho treba označiť ľavým 

tlačidlom myši a potom ešte kliknúť na tlačidlo OK: 
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Mračná bodov poskytované ÚGKK SR sú súradnicovom systéme S-JTSK[JTSK03] (kód EPSG:8353) 
alebo ETRS89-TM34 (kód EPSG:3046).    
Nakoniec po výbere súradnicového systému v okne Layer Properties kliknúť na tlačidlo Apply a OK:  

 
 

Súradnicový systém projektu, v ktorom sa budú zobrazovať všetky vrstvy, sa dá nastaviť v ľavom 

dolnom rohu mapového okna po kliknutí na tlačidlo Current CRS : 

 
Otvorí sa okno Project Properties – CRS, kde treba v časti Coordinate Reference System vybrať 

požadovaný súradnicový systém: 
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Súradnicový systém projektu je tak nastavený: 

 
 
Poznámka: Informácie o správnom nastavení súradnicových systémov a transformácií používaných 

na území Slovenska sú uvedené v návode Súradnicový systém S-JTSK[JTSK03] v QGIS  

(https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf). 

 
Pre trvalé priradenie súradnicového systému súboru mračna bodov treba použiť nástroj Assign 

projection, ktorý sa nachádza v paneli Processing Toolbox → Point cloud data management: 

Na výstupe vnikne nový súbor mračna bodov vo vybranom formáte. 

Po spustení tohto nástroja sa otvorí okno Point Cloud Data Management - Assign Projection, kde 

treba vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Desired CRS – po kliknutí na tlačidlo  Select CRS  vybrať správny súradnicový systém zo 

zoznamu v časti Predefined Coordinate Reference Systems alebo po zadaní EPSG  kódu 

daného súradnicového systému do políčka Filter: 

 

Pre návrat do hlavného okna kliknúť na tlačidlo Go back . 

• Output layer – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov, formát 

(LAS, LAZ, VPC) a umiestnenie výstupného súboru. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorená vrstva 

mračna bodov otvorí v projekte. 

https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf
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2. Pridanie mračien bodov zo servera alebo cloudu 
 

QGIS umožňuje prácu aj s mračnami bodov vo formáte ETP (Etwine Point Tile), ktoré môžu byť 

načítané zo vzdialeného servera HTTP(S). Príklady takýchto mračien bodov: 

• USGS LIDAR data:  https://usgs.entwine.io/  

(napr. https://s3-us-west-2.amazonaws.com/usgs-lidar-public/TN_Nashville_2011/ept.json) 

 

Pre ich pripojenie do projektu treba v hlavnom menu kliknúť na panel Layer → Add Layer → Add 

Point Cloud Layer. Následne sa otvorí sa okno Data Source Manager | Point Cloud. Tam v časti Source 

Type zvoliť možnosť Protocol:HTTP(S), cloud, etc. a do políčka Source zadať URL adresu na mračno 

bodov vo formáte ETP zo servera. V prípade zabezpečeného servera v časti Authentification → Bacis 

vyplniť prihlasovacie údaje: používateľské meno (User name) a heslo (Password). Nakoniec kliknúť 

na tlačidlo Add: 

https://entwine.io/entwine-point-tile.html
https://usgs.entwine.io/
https://s3-us-west-2.amazonaws.com/usgs-lidar-public/TN_Nashville_2011/ept.json
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Mračno bodov vo formáte ETP pridané do projektu: 
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3. Nastavenie symboliky 
 

Ofarbenie podľa klasifikácie 

Po pridaní mračna bodov do projektu sa automaticky nastaví symbolika (ofarbenie) bodov podľa 

hodnôt atribútu Classification (triedy klasifikácie): 

 
 

Od verzie QGIS 3.26. sa zobrazia iba tie triedy, ktoré sa nachádzajú v mračne bodov. Takisto sa 
už zobrazia aj iné triedy ako pôvodných 18 základných (tabuľka č. 1), ak sa v mračne bodov takéto 
triedy nachádzajú. 
 

Zmenu symboliky bodov je možné vykonať vo vlastnostiach vrstvy Properties v časti Symbology: 
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Zmenu ofarbenia bodov je možné urobiť tak, že v časti Color kliknúť na štvorček s farbou, následne 

vybrať požadovaný farebný odtieň a potom kliknúť na tlačidlo OK: 

 
 

V stĺpci Percentage je uvedené percentuálne zastúpenie bodov danej triedy vzhľadom na celkový 

počet bodov v mračne: 

 
 

V časti Point Symbol je možné nastaviť: 

• Point size - veľkosť symbolu. 

• Style - typ symbolu: Square (štvorec), Cicle (kruh). 

• Render as a Surface (Triangulate) – označenie tejto funkcie vykoná triangulácia vrstvy 

mračna bodov v 2D zobrazení a vykreslí ju v podobe siete trojuholníkov namiesto bodov. 

Označením políčka Skip triangles longer than je možné nastaviť krajnú hodnotu maximálnej 

dĺžky strany trojuholníkov, ktorá sa pri vykreslení zohľadní. To môže byť obzvlášť užitočné, 

ak je potrebné identifikovať diery v mračne bodov. 

Príklad vykreslenia bodov z triedy Ground: 
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V časti Layer Rendering je možné nastaviť parameter Opacity - priehľadnosť bodov. 
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Označenie jednotlivých tried bodov je možné upraviť po kliknutí na názov triedy v časti Legend: 

 
 

                       Tab. 1 Základné triedy klasifikácie bodov 

Classification  
[hodnota] 

Názov triedy  
[anglicky] 

Názov triedy  
[slovensky] 

1 Unclassified Neklasifikované 

2 Ground Reliéf (terén) 

3 Low Vegetation Nízka vegetácia 

4 Medium Vegetation Stredná vegetácia 

5 High Vegetation Vysoká vegetácia 

6 Building Budovy 

7 Low point (noise) Nízky šum 

8 Reserved - 

9 Water Voda 

10 Rail Koľajnice 

11 Road Surface Povrch vozovky 

12 Reserved - 

13 Wire – Guard (Shield) 
Elektrické vedenia (ochranné 

uzemňovacie vodiče) 

14 Wire – Conductor (Phase) Elektrické vedenia (vodiče) 

15 Transmission Tower 
Stožiare elektrického 

vedenia 

16 
Wire-Structure Connector 

(Insulator) 
Elektrické vedenia (izolátory) 

17 Bridge Deck Mosty 

18 Hight Noise Vysoký šum 

Informácie o klasifikácii mračna bodov poskytovaného GKÚ Bratislava sú uvedené na stránke  

https://www.geoportal.sk/sk/udaje/lls-dmr/o-projekte/ . 

 

https://www.geoportal.sk/sk/udaje/lls-dmr/o-projekte/
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Ofarbenie podľa hodnôt atribútu 

Postup nastavenie symboliky podľa atribútu: 

a) V hornom políčku nastaviť Attribute by Ramp. 

b) V políčku Attribute vybrať požadovaný atribút (napr. Intensity alebo Z) a kliknúť na tlačidlo 

Load. 

c) V políčku Interpolation vybrať Linear. 

d) V políčku Color Ramp vybrať farebnú škálu. 

e) V políčku Mode nastaviť spôsob zobrazenie (napr. Continuous (súvislé)). 

f) Kliknúť na tlačidlo Classify. 

g) Nastaviť parametre zobrazenia symbolov bodov (Point size, Style, Opacity). 

h) V prípade potreby zapnúť funkciu Render as a Surface (Triangulate). 

i) Nakoniec kliknúť na tlačidlo Apply a OK. 
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Zobrazenie mračna bodov podľa intenzity odrazeného laserového lúča: 

 
 

Atribút Intensity predstavuje hodnotu intenzity odrazeného laserového lúča, ktorý vygeneroval 

daný bod. Hodnota intenzity je založená aj na odrazivosti objektu zasiahnutého laserovým lúčom. 

Mení sa podľa zloženia povrchu objektu, od ktorého sa lúč odrazil. 

 

Zobrazenie mračna bodov podľa hodnôt výšky (súradnice Z) bodov: 
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Ofarbenie podľa hodnôt RGB 

Ak mračno bodov má vyplnené atribúty Blue, Green a Red, ktoré obsahujú hodnoty farieb bodov 
prevzatých napr. z leteckých snímok, tak je potom možné mračno zobraziť aj vo farebnej 
symbolike RGB: 
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Príklad takého mračna bodov z oblasti Amsterdamu (zdroj: https://geotiles.nl/): 

 
 

 

Eye-Dome Lighting efekt 

 

Eye-Dome Lighting je efekt osvetlenia mračna bodov, ktorý zvýši kontrast a pridáva jemné 

tieňovanie, vďaka čomu je v mračne bodov oveľa jednoduchšie identifikovať rôzne prvky, ktoré by 

inak to bolo ťažšie vidieť. 

Pre zapnutie funkcie Eye-Dome Lighting treba prejsť do hlavného menu do časti Project a tam do 

Properties: 

 

https://geotiles.nl/
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Potom v okne Project Properties v časti Elevation označiť políčko Global Map Shading.  

Funkcia Eye-Dome Lighting bude aktívna, ak je zapnuté políčko, ktoré sa pri nej nachádza. Zmenu 

nastavenia tejto funkcie je možnú urobiť v parametroch: 

• Strength - zväčšenie tohto parametra zvyšuje kontrast. 

• Distance - zväčšenie tohto parametra spôsobuje hrubšie okraje. 

 
 

Zobrazenie mračna bodov s nastavenou symbolikou podľa tried klasifikácie bez zapnutej funkcie Eye 

Dome Lighting: 
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Príklady zobrazenie mračna bodov so zapnutou funkciou Eye Dome Lighting: 

• nastavenie parametrov Strength = 1000 a Distance = 0,5: 

 
 

• nastavenie parametrov Strength = 3000 a Distance = 0,5: 
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• natavenie parametrov Strength = 2000 a Distance = 2: 

 
 

 

Zobrazenie vybraných tried bodov 

Ak je potrebné zobraziť len vybranú alebo vybrané triedy bodov, tak treba nechať okne Symbology 

alebo v paneli Layers označené iba tie: 
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Zobrazenie len bodov z triedy budovy (Building): 

 
 

4. Identifikácia hodnôt atribútov bodov 
 

Hodnoty atribútov jednotlivých bodov mračna bodov je možné zistiť v mapovom okne pomocou 

nástroja Identify Features , ktorý sa nachádza v paneli Attribute Toolbar: 

 
Panel Attribute Toolbar je možné zapnúť po kliknutí na panel View v hlavnom menu, kde vybrať 

Toolbars a označiť Attribute Toolbar. 

Po označení ikonky  tohto nástroja myšou sa v mapovom okne priblížiť a kliknúť ľavým tlačidlom 

myši na zvolený bod: 

 
 

Následne sa otvorí okno Identify Results s výsledkami identifikácie, kde sú uvedené hodnoty 

atribútov napr.: 

• Classification – označenie triedy klasifikácie, do ktorej bod patrí. 

• Intensity – intenzita odrazeného laserového lúča, ktorý vygeneroval daný bod. 

• X, Y, Z – priestorové súradnice bodu. 

 



23 
 

 

 

5. Výber bodov podľa hodnôt atribútov 
 

Z mračna bodov je možné vybrať, zobraziť alebo následne aj vyexportovať do iného súboru len 

vybrané body podľa zvolenej podmienky pomocou nasledujúcich nástrojov Filter: 

1) Filter – nástroj je možné spustiť po kliknutí pravým tlačidlom myši na vrstvu mračna bodov 

v paneli Layers: 
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Po spustení tohto nástroja sa otvorí okno Query Filter, kde sa v časti Fields zobrazia atribúty, ktoré 

súbor mračna bodov obsahuje, v časti Values sa zobrazia hodnoty vybraného atribútu a do časti 

Provider Specific Filter Expression treba zadať podmienku na výber bodov. Nakoniec treba kliknúť na 

tlačidlo OK: 
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Pomocou nástroja Filter je možné mračno bodov selektovať napr. podľa: 

• triedy klasifikácie 

•  príklad výberu bodov len z triedy Building (Classification = 6): 

 
 

Výsledok: 

 
 

• hodnôt súradnice Z (výšky) 

•  príklad výberu bodov s nadmorskou výškou nad 170 m  (Z > 170): 
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Výsledok: 

 
 

• hodnôt intenzity 

•  príklad výberu bodov zo zvoleného intervalu hodnôt intenzity od 10000 do 15000 
(Intensity > 10000 AND Intensity < 15000) 

 
Výsledok: 

 
 
 
 
 



27 
 

• výber podľa hodnôt viacerých atribútov 

• príklad výberu bodov z triedy Building s nadmorskou výškou nad 170 m  

(Classification = 6 AND Z > 170): 

 
 

Výsledok: 

 
 

Takto vybrané body podľa zvolenej podmienky je následné možné vyexportovať do iného súboru 

vo zvolenom formáte  (LAS, LAZ, GeoPackage, ESRI Shapefile, DXF, CSV) podľa postupu uvedeného  

v 6. kapitole. 
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2) Filter - umožňuje výber bodov zo vstupnej vrstvy mračna bodov na základe zadanej podmienky 

alebo zvolenej oblasti do formátov LAS, LAZ, VPC. Nástroj sa nachádza v paneli Processing Toolbox 

→ Point cloud extraction: 

 
 

Po spustení tohto nástroja sa otvorí okno Point Cloud Extraction - Filter,  kde treba vyplniť 

požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Filter expression – zadať podmienku pre výber vybranej podmnožiny bodov z mračna bodov 

(napr. vybrané triedy klasifikácie). Príklad výberu bodov z triedy č. 6 Buildings (budovy): 
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• Cropping extent – zadanie priestorového rozsahu pre výber podmnožiny bodov 

z mračna bodov (voliteľný parameter). Dostupné metódy: 

▪ Calculate from Layer - použije sa priestorový rozsah (bounding box - BBOX) 

vrstvy načítanej v aktuálnom projekte. 

 
• Calculate from Layout Map - použije sa priestorový rozsah nastavený 

v uloženom mapovom projekte pre tlač (layout map item). 

• Calculate from Bookmark - použije sa priestorový rozsah z uloženej záložky 

nastaveného obsahu mapového okna (bookmark). 

• Use Current Map Canvas Extent - použije sa nastavený priestorový rozsah 

mapového okna. 

• Draw on Map Canvas - kliknúť do mapového okna a nakresliť obdĺžnik 

ohraničujúci oblasť, z ktorej sa vyberú body.  

• Do políčka priamo zadať súradnice priestorového ohraničenia v tvare xmin, 

xmax, ymin, ymax. 

• Filtered – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov, formát (LAS, 

LAZ, VPC)  a umiestnenie výstupného súboru. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorená vrstva 

mračna bodov otvorí v projekte. 

 

Príklad výberu bodov z triedy č. 6 Buildings (budovy) a podľa ohraničenia zvolenej polygónovej 

vrstvy: 

 
 
 

https://docs.qgis.org/testing/en/docs/user_manual/print_composer/composer_items/composer_map.html#layout-map-item
https://docs.qgis.org/testing/en/docs/user_manual/map_views/map_view.html#sec-bookmarks
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Vstupná vrstva mračna bodov a polygónová vrstva pre výber bodov: 

 
 

Výsledok výberu bodov z triedy č. 6 Buildings (budovy) podľa priestorového ohraničenia (BBOX) 

zvolenej polygónovej vrstvy: 

 
 

Príklad výberu všetkých bodov z mračna bodov podľa priestorového ohraničenia (BBOX) zvolenej 

polygónovej vrstvy: 
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6. Export do iných formátov 
 

Mračno bodov je možné vyexportovať celé alebo iba jeho časť vybranú podľa postupu uvedeného 

v 5. kapitole do nasledujúcich formátov:  

• LAS 

• LAZ 

• GeoPackage 

• ESRI Shapefile 

• DXF 

• CSV (Comma separated values) 

Na export mračna bodov do iných formátov slúžia nástroje: 

1) Export → Save as – nástroj je možné spustiť po kliknutí pravým tlačidlom myši na vrstvu 

mračna bodov v paneli Layers: 

 

Po spustení tohto nástroja sa otvorí okno Save Vector Layer as, kde treba vyplniť požadované 

parametre a potom kliknúť na tlačidlo OK: 

• Format – zvoliť formát výstupného súboru. 

• File name – zadať názov a umiestnenie výstupného súboru. 

• Layer name – zadať názov vrstvy vo výstupnom súbore. 

• CRS – zvoliť súradnicový systém výstupného súboru. Týmto spôsobom je tak možné body 

pretransformovať aj do iného polohového súradnicového systému (7. kapitola). 

• Select fields to export – po označení tohto políčka bude výstupný súbor obsahovať všetky 

alebo len vybrané atribúty mračna bodov: 
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Ak sa nechá políčko neoznačené, tak vo výstupnom súbore sa bude nachádzať len 

identifikátor bodu (napr. fid pri formáte GeoPackage). 

• Extent – označiť v prípade, ak je potrebné vyexportovať mračno bodov podľa 

priestorového ohraničenie mapového okna (Map Canvas Extent): 

 
 alebo inej vrstvy (Calculate from: Layer): 

 
• Filter by Polygon Layer – označiť v prípade, ak je potrebné vyexportovať body, ktoré sa 

nachádzajú len v oblasti zvolenej polygónovej vrstvy: 

 
• Elevation range – označiť v prípade, ak je potrebné vyexportovať body len zo zvoleného 

výškového intervalu: 
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• Limit number of points – označiť v prípade, ak je potrebné vyexportovať len určitý zvolený 

počet bodov (Limit total number of exported points to): 

 

 

Príklad exportu mračna bodov do formátu GeoPackage. 
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Ukážky exportov 

Vstupná vrstva mračna bodov a polygón pre výber bodov: 

 
 

Výstupný súbor vo formáte GeoPackage so všetkými bodmi a atribútmi: 
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Výstupný súbor vo formáte GeoPackage obsahujúci len body vybrané podľa priestorového 

ohraničenia zvolenej vrstvy (Extent → Calculate from: Layer): 

 
 

Výstupný súbor vo formáte GeoPackage obsahujúci len body vybrané podľa hraníc zvoleného 

polygónu (Filter by polygon layer): 

 
 

Výstupný súbor vo formáte GeoPackage obsahujúci len vo zvolenom výškovom intervale od 165 m 

do 200 m (Elevation Range): 
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Výstupný súbor vo formáte GeoPackage obsahujúci len zvolený počet bodov (Limit number of 

points): 

 

Výstupný súbor vo formáte DXF zobrazený v softvéri Bentley MocroStation V8i: 

 
 

Upozornenie: Vyexportované DXF súbory majú nastavené ako meracie jednotky inches (palce).  

Je to z dôvodu používaného zdrojového súboru header.dxf (jeho umiestnenie v QGIS 3.28.3: 

C:\Program Files\QGIS 3.28.3\apps\gdal\share\gdal), kde je nastavené pri parametroch 

$MEASUREMENT=0 (English) a $INSUNITS=1 (Inches) 

Pre konverziu do jednotiek metrov treba tento súbor upraviť v textovom editore (napr. Notepad++ 

atď.) a nastaviť správne hodnoty pre parametre $MEASUREMENT=1 (Metric) a $INSUNITS=6 

(Meters): 

$MEASUREMENT 

70 

     1 

$INSUNITS  

 70 

     6 

Viac informácií o nastavených jednotkách v DXF súbore na stránke: 

https://ezdxf.readthedocs.io/en/stable/concepts/units.html 

https://ezdxf.readthedocs.io/en/stable/concepts/units.html
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Export vybranej časti bodov 

Príklad výberu bodov z triedy Building vyexportovaných do formátu ESRI Shapefile: 

1. Ako prvý krok si treba vybrať body podľa zvolenej podmienky pomocou nástroja Filter  

(5. kapitola): 
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2. Potom na export vybraných bodov do zvoleného formátu použiť nástroj Export → Save as: 

 
 

Výsledok exportu: 
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Príklad výberu bodov z triedy Building vyexportovaných do formátu LAS zobrazených v softvéri 

CloudCompare (https://www.danielgm.net/cc/): 

 
 
 

2) Convert format - nástroj slúži na konverziu mračna bodov na iný formát súboru: LAS, LAZ, VPC. 

Nástroj sa nachádza v paneli Processing Toolbox → Point cloud conversion: 

 
Po spustení tohto nástroja sa otvorí okno Point Cloud Conversion – Convert Format, kde treba 

vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Converted – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov, formát 

a umiestnenie výstupného súboru. 

• Open output file after running algorithm – po označení tohto políčka sa prekonvertovaná 

vrstva mračna bodov otvorí v projekte. 

 

https://www.danielgm.net/cc/
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3) Export to vector – nástroj slúži na export mračien bodov do vektorovej 3D bodovej vrstvy vo 

formáte GeoPackage. Nástroj sa nachádza v paneli Processing Toolbox → Point cloud conversion: 

 
 

Po spustení tohto nástroja sa otvorí okno Point Cloud Conversion – Export to Vector kde treba vyplniť 

požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Attribute – vybrať atribúty z vrstvy mračna bodov, ktoré sa vyexportujú (voliteľný 

parameter). Odporúčané je vybrať len potrebné atribúty z dôvodu veľkosti výstupného 

súboru GeoPackage. 



41 
 

 
• Filter expression – zadanie podmienky pre výber vybranej podmnožiny bodov z mračna 

bodov (napr. vybrané triedy klasifikácie) (voliteľný parameter). 

• Cropping extent – zadanie priestorového rozsahu pre výber podmnožiny bodov z mračna 

bodov (voliteľný parameter). Dostupné metódy: 

• Calculate from Layer - použije sa priestorový rozsah (bounding box - BBOX) vrstvy 

načítanej v aktuálnom projekte. 

• Calculate from Layout Map - použije sa priestorový rozsah nastavený v uloženom 

mapovom projekte pre tlač (layout map item). 

• Calculate from Bookmark - použije sa priestorový rozsah z uloženej záložky 

nastaveného obsahu mapového okna (bookmark). 

• Use Current Map Canvas Extent - použije sa nastavený priestorový rozsah mapového 

okna. 

• Draw on Map Canvas - kliknúť do mapového okna a nakresliť obdĺžnik ohraničujúci 

oblasť, z ktorej sa vyberú body.  

• Do políčka priamo zadať súradnice priestorového ohraničenia v tvare xmin, xmax, 

ymin, ymax. 

• Exported – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov 

a umiestnenie výstupného súboru vo formáte GeoPackage. 

• Open output file after running algorithm – po označení tohto políčka sa prekonvertovaná 

vektorová vrstva mračna bodov otvorí v projekte. 

 

 

 

 

 

 

 

 

 

 

https://docs.qgis.org/testing/en/docs/user_manual/print_composer/composer_items/composer_map.html#layout-map-item
https://docs.qgis.org/testing/en/docs/user_manual/map_views/map_view.html#sec-bookmarks
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Príklad exportu bodov z triedy č. 2 Ground (terén): 

 
 

Výsledok exportu: 
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7. Transformácia do iného polohového súradnicového systému 
 

Mračno bodov je možné pretransformovať do iného polohového súradnicového systému.  

Pre presnú transformáciu údajov treba mať v QGIS nastavené správne transformácie medzi 

súradnicovými systémami podľa návodu: https://www.geoportal.sk/files/gz/s-

jtsk_jtsk03_v_qgis.pdf. Tiež treba pred transformáciou skontrolovať a nastaviť správny súradnicový 

systém vrstvy mračna bodov podľa postupu uvedeného v 1. kapitole. 

Na transformáciu súradníc bodov slúži podobne ako na export do iného formátu (6. kapitola) 

nástroj Export → Save as, ktorý je možné spustiť po kliknutí pravým tlačidlom myši na vrstvu 

mračna bodov v paneli Layers: 

 

Po spustení tohto nástroja sa otvorí okno, kde treba vyplniť požadované parametre a potom kliknúť 

na tlačidlo OK: 

• Format – zvoliť formát výstupného súboru (LAS, LAZ, GeoPackage, ESRI Shapefile, DXF, CSV). 

• File name – zadať názov a umiestnenie výstupného súboru. 

• Layer name – zadať názov vrstvy vo výstupnom súbore. 

• CRS – zvoliť súradnicový systém výstupného súboru.  

• Select fields to export – po označení tohto políčka bude výstupný súbor obsahovať všetky 

alebo len vybrané atribúty mračna bodov. 

• Extent – označiť v prípade, ak je potrebné vyexportovať mračno bodov len podľa 

priestorového ohraničenie mapového okna (Map Canvas Extent) alebo inej vrstvy 

(Calculate from: Layer). 

• Filter by Polygon Layer – označiť v prípade, ak je potrebné vyexportovať body, ktoré sa 

nachádzajú len v oblasti zvolenej polygónovej vrstvy. 

• Elevation range – označiť v prípade, ak je potrebné vyexportovať body len zo zvoleného 

výškového intervalu, 

• Limit number of points – označiť v prípade, ak je potrebné vyexportovať len určitý zvolený 

počet bodov (Limit total number of exported points to). 

https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf
https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf


44 
 

 
 

Ukážka pretransformovaného mračna bodov zo súradnicového systému S-JTSK[JTSK03] (kód 

EPSG:8353) do S-JTSK[JTSK] (kód EPSG:5514) v porovnaní s katastrálnymi parcely C, ktoré je možné 

bezodplatne stiahnuť vo formáte GeoPackage a súradnicovom systéme S-JTSK[JTSK] (kód 

EPSG:5514) z webovej aplikácie Atribúty katastrálneho operátu (https://ako.vugk.sk/): 

 

 

https://ako.vugk.sk/
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8. 3D zobrazenie 
 

Na zobrazenie mračna bodov v 3D pohľade je možné použiť funkciu New 3D Map View, ktorá sa 

nachádza v hlavnom menu v paneli View v časti 3D Map Views: 

 
 

Po spustení sa otvorí nové mapové okno 3D Map, v ktorom je možné mračno bodov prehliadať: 
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Nastavenie symboliky 

Nastavenie symboliky bodov v 3D zobrazení je možné vykonať vo vlastnostiach vrstvy Properties v 

časti 3D View:  

 
Možnosti nastavenia symboliky: 

• No Rendering – mračno bodov sa v 3D pohľade nebude zobrazovať. 

• Follow 2D Symbology – nastavenie symboliky sa preberie z 2D zobrazenia z časti Properties 

→  Symbology.  

• Single Color – body sa ofarbia podľa zvolenej farby. 
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• Attributte by Ramp – umožňuje nastaviť symboliku podľa zvoleného atribútu. 

Príklad 3D zobrazenia mračna bodov podľa atribútu Intensity: 

 
 

• RBG – symbolika bodov sa nastaví podľa atribútov Blue, Green a Red, ktoré obsahujú 

hodnoty farieb bodu prevzatých napr. z leteckých snímok. 

Príklad 3D zobrazenia mračna bodov v symbolike RGB (zdroj: https://geotiles.nl/ ): 

 
• Classification – nastavenie symboliky podľa tried klasifikácie. 

Príklad 3D zobrazenia mračna bodov podľa tried klasifikácie: 

 
 

 

https://geotiles.nl/
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Príklad 3D zobrazenia len vybraných tried budovy (Building) a vegetácia (Medium a High 

Vegetation): 

 
 

V časti Point Symbol je možné nastaviť: 

• Point size - veľkosť bodového symbolu, 

• Render as Surface (Triangulate) – po označení sa mračno bodov vykreslí v podobe 3D 

modelu, podobne ako digitálny model povrchu: 

 
 

Príklad 3D zobrazenia mračna bodov pri zapnutej funkcii Render as Surface: 

- všetky triedy klasifikácie 
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- len trieda Groud (reliéf) 

 
 

Funkcia Eye Dome Lighting 

Efekt osvetlenia tzv. „Eye Dome Lighting“, ktorý zvýši kontrast pridáva jemné tieňovanie, vďaka 

čomu je v mračne bodov oveľa jednoduchšie identifikovať rôzne prvky, ktoré by inak to bolo ťažšie 

vidieť. Funkciu Eye Dome Lighting je v 3D mapovom okne možné zapnúť po kliknutí na tlačidlo 

Effects  a označení políčka Show Eye Dome Lighting: 

 

Alebo túto funkciu je možné zapnúť po kliknutí na tlačidlo Options  a v časti Effects označiť políčko 

Show Eye Dome Lighting, kde je možné meniť hodnoty parametrov Lighting strength a Lighting 

distance, a nakoniec kliknúť na tlačidlá Apply a OK: 
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3D zobrazenie mračna bodov so zapnutou funkciou Eye Dome Lighting: 

 
 

9. Zobrazenie na podklade DMR a ortofotomozaiky 
 

Raster digitálneho model reliéfu (DMR) je možné pridať do projektu a zobraziť v mapovom okne 

podľa postupu uvedeného v 1. kapitole návodu: https://www.geoportal.sk/files/zbgis/lls/navod-

pracu-dmr-qgis.pdf.  

Podobným spôsobom sa postupuje aj pri rastroch ortofotomozaiky, kde postup je uvedený 

v návode: https://www.geoportal.sk/files/zbgis/navody/navod_ortofotomozaika_qgis.pdf 

DMR je vhodné zobraziť vo forme tieňovaného reliéfu (hillshade), ktorý je možné vytvoriť pomocou 

nástroja Hillshade nachádzajúceho sa v paneli nástrojov Raster → Analysis (2. kapitola v návode na 

prácu s DMR v QGIS). V paneli Layers tieto vrstvy DMR a ortofotomozaiky umiestniť pod vrstvy s 

mračnami bodov, aby ich neprekrývali: 

 

https://www.geoportal.sk/files/zbgis/lls/navod-pracu-dmr-qgis.pdf
https://www.geoportal.sk/files/zbgis/lls/navod-pracu-dmr-qgis.pdf
https://www.geoportal.sk/sk/udaje/ortofotomozaika/
https://www.geoportal.sk/files/zbgis/navody/navod_ortofotomozaika_qgis.pdf
https://www.geoportal.sk/files/zbgis/lls/navod-pracu-dmr-qgis.pdf
https://www.geoportal.sk/files/zbgis/lls/navod-pracu-dmr-qgis.pdf
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Pre 3D zobrazenie DMR a rastrov ortofotomozaiky treba v okne 3D Map kliknúť na ikonku Options 

 a potom vybrať Configure. Následne v okne 3D Configuration v časti Terrain nastaviť 

požadované parametre a kliknúť na tlačidlá Apply a OK: 

• Type – vybrať možnosť DEM (Raster Layer). 

• Elevation – vybrať vrstvu DMR. 

• Tile resolution – nastaviť hodnotu rozlíšenia mapovej dlaždice (napr. 128 px). 

 
 

3D zobrazenie triedy budovy (Building) z mračna bodov na podklade DMR vo forme hillshade: 
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3D zobrazenie tried budovy (Building), vegetácia (Medium a High Vegetation) a mosty (Bridge 

Deck) z mračna bodov na podklade ortofotomozaiky: 

 
 
 

10. Odmeranie výškového profilu 
 

Výškový profil z mračna bodov je možné odmerať pomocou nástroja Elevation profile, ktorý sa 

nachádza v paneli nástrojov View: 
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Po spustení tohto nástroja sa otvorí ono Elevation Profile, kde je možné: 

• V pravej časti vybrať vrstvy mračien bodov, ktoré sa použijú na merane výškového profilu. 

Zobrazenie zoznamu vrstiev je možné vypnúť po kliknutí na tlačidlo Show Layer Tree : 

 
• Po kliknutí na tlačidlo Capture Curve  nakresliť líniu priebehu výškového profilu. 

Nakreslená línia sa ukončí kliknutím pravým tlačidlom myši. 

• Po kliknutí na tlačidlo Capture Curve From Feature  je možné ako priebeh výškového 

profilu použiť vektorovú líniovú vrstvu pridanú v projekte. Túto líniovú vrstvu treba mať 

v projekte zapnutú a po aktivovaní nástroja Capture Curve From Feature na ňu kliknúť 

v mapovom okne. 

• Po kliknutí na tlačidlo Clear  sa odstráni odmeraný výškový profil. 

• Po kliknutí na tlačidlo Export as PDF  sa vykreslený profil vyexportuje do dokumentu vo 

formáte PDF. 

• po kliknutí na tlačidlo Export as Image  sa vykreslený profil vyexportuje do obrázku vo 

formáte PNG. 

• V grafe s vykresleným výškovým profilom je možné sa približovať a oddiaľovať po kliknutí 

na tlačidlo Zoom , posúvať sa po kliknutí na tlačidlo Pan , identifikovať body a zobraziť 

ich atribúty po kliknutí na tlačidlo Identify Feature , merať vzdialenosti a výškové 

rozdiely medzi bodmi po kliknutí na tlačidlo Measure Distance , uchytávať sa presne na 

body napr. pri meraní po kliknutí na tlačidlo  Enable Snapping : 
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• Po kliknutí na tlačidlo Export Results   je možné vyexportovať vrstvy vo formáte (napr. 
GeoPackage, ESRI Shapefile), ktoré budú obsahovať nasledovné údaje: 

 
• Export 3D Features – body z mračna bodov v tesnej blízkosti vyznačeného profilu: 

 
 

• Export 2D profile – výškový profil znázornený ako bodový graf vzdialeností bodov od 
začiatku profilu a nadmorskej výšky: 

 
 

• Export Distance/Elevation table – tabuľka bodov profilu s hodnotami vzdialeností bodov od 
začiatku profilu a nadmorskej výšky: 
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Ukážka výškového profilu po nakreslení línie profilu v mapovom okne (Create Curve): 

 
 

Ukážka  výškového profilu vytvoreného podľa líniovej vrstvy pridanej v projekte (Capture Curve 

From Feature): 
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11. Vytvorenie tlačových výstupov 
 

Obsah mapového okna (2D aj 3D) je možné vytlačiť na tlačiarni alebo vyexportovať do rôznych 

formátov napr. PDF, PNG, JPEG alebo SVG pomocou nástroja New Print Layout, ktorý sa nachádza 

v paneli Project: 

 
 

Po spustení sa objaví okno Create print layout, kde treba zadať názov tlačového výstupu a kliknúť 

na tlačidlo OK: 
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Následne sa otvorí okno Print Layout, kde kliknúť pravým tlačidlom myši do bieleho obdĺžnika 

v strede okna, ktorý reprezentuje plochu pre tlač. Po kliknutí vybrať možnosť  Page Properties: 

 

Potom v pravom paneli Items v časti Items properties je možné nastaviť formát (Size), orientáciu 

(Orientation) strany pre tlač a farbu pozadia (Background): 
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Pre tlač 2D mapy v ľavom paneli nástrojov kliknúť na tlačidlo Add Map  a v okne pre tlač pomocou 

myšky nakresliť obdĺžnik, ktorý bude predstavovať priestorové ohraničenie mapového okna: 

 

Po nakreslení tohto obdĺžnik sa zobrazí aktuálny obsah mapového okna nastaveného v projekte: 

 

V pravom paneli Items v časti Items Properties je možné nastaviť rôzne parametre pre tlač mapy 

napríklad: 

• Scale – mierka mapy, 

• Map rotation – uhol rotácie mapy, 

• CRS – súradnicový systém, v ktorom  sa budú údaje zobrazovať. 
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Mapu v okne pre tlač je možné posúvať pomocou nástroja Interactively Edit Map Extent . 

 
 

V časti Layout je možné nastaviť napr. rozlíšenie (dpi) vyexportovaného súboru: 
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Pre tlač 3D mapy v ľavom paneli nástrojov kliknúť na tlačidlo Add 3D Map  a v okne pre tlač 

pomocou myšky nakresliť obdĺžnik, ktorý bude predstavovať priestorové ohraničenie mapového 

okna. Následne v ľavom paneli Items v časti Items Properties kliknúť na tlačidlo Copy Settings from 

a 3D View a tam vybrať 3D mapové okno z projektu: 

 
 

Po tomto kroku sa zobrazí aktuálny obsah 3D mapového okna z projektu: 
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Taktiež je možné do tlačového výstupu pomocou nástrojov v ľavom paneli doplniť: 

• Add Picture  - obrázok, 

• Add Label  - text, 

• Add Legend  - legenda, 

• Add Scale Bar  - mierka, 

• Add North Arrow  - severka, 

• Add Shape  - geometrický tvar, 

• Add Marker  - značka, 

• Add Arrow  šípka, 

• Add Node Item  - línia alebo polygón, 

• Add Atribute Table  - atribútová tabuľka vrstvy z projektu, 

• Add Fixed Table  - vlastná tabuľka, 

• Add Elevation Profile  - graf výškového profilu vytvoreného v projekte (pridanie do 

tlačového okna pomocou tlačidla Copy From Profile ). 
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Takto pripravené údaje pre tlač je pomocou nástrojov v hlavnom paneli možné: 

 

a) Print Layout  - vytlačiť v pripojenej tlačiarni, 

b) Export as image  - vyexportovať ako obrázok (PNG, JPG), 

c) Export as SVG  - vyexportovať ako súbor SVG, 

d) Export as PDF  - vyexportovať ako súbor PDF. 

 

Jednotlivé vytvorené mapové projekty pre tlač (Print Layouts) je možné nájsť v paneli Project → 

Layout Manager: 

 
 

12. Vygenerovanie metaúdajov o súbore mračna bodov 
 

Na vygenerovanie základných metaúdajov o súbore mračna bodov slúži nástroj Information, ktorý 

sa nachádza v paneli Processing Toolbox → Point cloud data management: 
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Po spustení tohto nástroja sa otvorí okno Point Cloud Data Management– Information, kde treba 

vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Layer information – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov 

a umiestnenie výstupného HTML súboru. 

 
 

Výstupný HTML súbor obsahuje meteúdaje o súbore mračna bodov - formát súboru, počet bodov 

(count), súradnicový systém (crs), priestorový rozsah (extent), jednotky (units), atribúty a ich 

dátový typ (attributes): 
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13. Vytvorenie rastra hustoty bodov 

 
Na vytvorenie rastra hustoty bodov vrstvy mračna bodov slúži nástroj Density. Výstupom je raster, 

ktorého každá bunka obsahuje počet bodov z mračna bodov, ktoré sa nachádzajú v oblasti danej 

bunky rastra. Nástroj Density sa nachádza v paneli Processing Toolbox → Point cloud extraction: 

 
 

Po spustení tohto nástroja sa otvorí okno Point Cloud Extraction - Density,  kde treba vyplniť 

požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Resolution of the density raster – zadať veľkosť bunky výstupného rastra. 

• Filter expression – zadanie podmienky pre výber vybranej podmnožiny bodov z mračna 

bodov (napr. vybrané triedy klasifikácie) (voliteľný parameter). 

• Cropping extent - zadanie priestorového rozsahu pre výber podmnožiny bodov z mračna 

bodov (voliteľný parameter). Dostupné metódy: 

• Calculate from Layer - použije sa priestorový rozsah (bounding box - BBOX) vrstvy 

načítanej v aktuálnom projekte. 

• Calculate from Layout Map - použije sa priestorový rozsah nastavený v uloženom 

mapovom projekte pre tlač (layout map item). 

• Calculate from Bookmark - použije sa priestorový rozsah z uloženej záložky 

nastaveného obsahu mapového okna (bookmark). 

• Use Current Map Canvas Extent - použije sa nastavený priestorový rozsah 

mapového okna. 

• Draw on Map Canvas - kliknúť do mapového okna a nakresliť obdĺžnik ohraničujúci 

oblasť, z ktorej sa vyberú body.  

• Do políčka priamo zadať súradnice priestorového ohraničenia v tvare xmin, xmax, 

ymin, ymax. 

https://docs.qgis.org/testing/en/docs/user_manual/print_composer/composer_items/composer_map.html#layout-map-item
https://docs.qgis.org/testing/en/docs/user_manual/map_views/map_view.html#sec-bookmarks
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• Density – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov 

a umiestnenie výstupného súboru vo formáte GeoPackage. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorená vrstva 

otvorí v projekte. 

 
 

Výsledný raster hustoty mračna bodov: 
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14. Vytvorenie polygónu hranice vrstvy mračna bodov 
 

Na vytvorenie vektorového polygónu predstavujúceho priestorové ohraničenie vrstvy mračna 

bodov slúži nástroj Boundary. Vytvorený polygón môže obsahovať diery, ktoré vzniknú v miestach 

bez bodov - napr. v oblastiach, kde nebolo mračno bodov naskenované (vodné plochy, plochy pod 

vegetáciou a budovami). Nástroj Boundary sa nachádza v paneli Processing Toolbox → Point cloud 

extraction: 

 
 

Po spustení tohto nástroja sa otvorí okno Point Cloud Extraction - Boundary kde treba vyplniť 

požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Resolution of cells used to calculate boundary – zadať veľkosť buniek použitých na výpočet 

hranice (voliteľný parameter). 

• Minimal number of points in a cell consider cell occupied – zadať minimálny počet bodov v 

bunke, ktorá sa bude považovať za obsadenú bunku pri výpočte polygónu hranice (voliteľný 

parameter). 

• Filter expression - zadanie podmienky pre výber vybranej podmnožiny bodov z mračna 

bodov (napr. vybrané triedy klasifikácie) (voliteľný parameter). 

• Cropping extent - zadanie priestorového rozsahu pre výber podmnožiny bodov z mračna 

bodov (voliteľný parameter). Dostupné metódy: 

• Calculate from Layer - použije sa priestorový rozsah (bounding box - BBOX) vrstvy 

načítanej v aktuálnom projekte. 

• Calculate from Layout Map - použije sa priestorový rozsah nastavený v uloženom 

mapovom projekte pre tlač (layout map item). 

• Calculate from Bookmark - použije sa priestorový rozsah z uloženej záložky 

nastaveného obsahu mapového okna (bookmark). 

https://docs.qgis.org/testing/en/docs/user_manual/print_composer/composer_items/composer_map.html#layout-map-item
https://docs.qgis.org/testing/en/docs/user_manual/map_views/map_view.html#sec-bookmarks
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• Use Current Map Canvas Extent - použije sa nastavený priestorový rozsah 

mapového okna. 

• Draw on Map Canvas - kliknúť do mapového okna a nakresliť obdĺžnik ohraničujúci 

oblasť, z ktorej sa vyberú body.  

• Do políčka priamo zadať súradnice priestorového ohraničenia v tvare xmin, xmax, 

ymin, ymax. 

• Boundary – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov 

a umiestnenie výstupného súboru vo formáte GeoPackage. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorená vrstva 

otvorí v projekte. 
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Vstupná vrstva mračna bodov: 

 
 

Výstupný polygón s hranicou vrstvy mračna bodov: 
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Zobrazenie polygónu s hranicou a vstupnej vrstvy mračna bodov: 

 
 

15. Vytvorenie zriedenej vrstvy mračna bodov 
 

Zriedenie počtu bodov podľa zvolenej vzdialenosti 

Na vytvorenie zriedenej vrstvy mračna bodov vykonaním prevzorkovania podľa zvolenej 

vzdialenosti (polomeru), slúži nástroj Thin (by sampling radius), ktorý sa nachádza v paneli 

Processing Toolbox → Point cloud data management: 
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Po spustení tohto nástroja sa otvorí okno Point Cloud Data Management - Thin (by Sampling 

Radius), kde treba vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Sampling radius (in map units) – zadať vzdialenosť, v rámci ktorej sa body prevzorkujú do 

jedinečného bodu. 

• Filter expression – zadanie podmienky pre výber vybranej podmnožiny bodov z mračna 

bodov (napr. vybrané triedy klasifikácie) (voliteľný parameter). 

• Cropping extent – zadanie priestorového rozsahu pre výber podmnožiny bodov z mračna 

bodov (voliteľný parameter). Dostupné metódy: 

• Calculate from Layer - použije sa priestorový rozsah (bounding box - BBOX) vrstvy 

načítanej v aktuálnom projekte. 

• Calculate from Layout Map - použije sa priestorový rozsah nastavený v uloženom 

mapovom projekte pre tlač (layout map item). 

• Calculate from Bookmark - použije sa priestorový rozsah z uloženej záložky 

nastaveného obsahu mapového okna (bookmark). 

• Use Current Map Canvas Extent - použije sa nastavený priestorový rozsah 

mapového okna. 

• Draw on Map Canvas - kliknúť do mapového okna a nakresliť obdĺžnik ohraničujúci 

oblasť, z ktorej sa vyberú body.  

• Do políčka priamo zadať súradnice priestorového ohraničenia v tvare xmin, xmax, 

ymin, ymax. 

• Thinned (by radius) – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov, 

formát (LAS, LAZ, VPC) a umiestnenie výstupného súboru. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorená vrstva 

mračna bodov otvorí v projekte. 

 

https://docs.qgis.org/testing/en/docs/user_manual/print_composer/composer_items/composer_map.html#layout-map-item
https://docs.qgis.org/testing/en/docs/user_manual/map_views/map_view.html#sec-bookmarks
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Vstupná vrstva mračna bodov pre triedu č. 2 Groud (terén): 

 
 

Výsledná zriedená vrstva mračna bodov pre triedu č. 2 Groud (terén) s nastaveným parametrom 

Sampling radius = 1  m: 

 
 

Výsledná zriedená vrstva mračna bodov pre triedu č. 2 Groud (terén) s nastaveným parametrom 

Sampling radius = 5  m: 
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Zriedenie počtu bodov ponechaním každého n-tého bodu 

Na vytvorenie zriedenej vrstvy mračna bodov tak, že sa ponechá len každý n-tý bod, slúži nástroj 

Thin (by skipping points), ktorý sa nachádza v paneli Processing Toolbox → Point cloud data 

management: 

 
 

Po spustení tohto nástroja sa otvorí okno Point Cloud Data Management - Thin (by Skipping 

Points), kde treba vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Number of points to skip – zadať hodnotu, podľa ktorej ponechaný bude iba každý n-tý bod 

(napr. 5 pre ponechanie každého 5. bodu). 

• Filter expression – zadanie podmienky pre výber vybranej podmnožiny bodov z mračna 

bodov (napr. vybrané triedy klasifikácie) (voliteľný parameter). 

• Cropping extent – zadanie priestorového rozsahu pre výber podmnožiny bodov z mračna 

bodov (voliteľný parameter). Dostupné metódy: 

• Calculate from Layer - použije sa priestorový rozsah (bounding box - BBOX) vrstvy 

načítanej v aktuálnom projekte. 

• Calculate from Layout Map - použije sa priestorový rozsah nastavený v uloženom 

mapovom projekte pre tlač (layout map item). 

• Calculate from Bookmark - použije sa priestorový rozsah z uloženej záložky 

nastaveného obsahu mapového okna (bookmark). 

• Use Current Map Canvas Extent - použije sa nastavený priestorový rozsah 

mapového okna. 

• Draw on Map Canvas - kliknúť do mapového okna a nakresliť obdĺžnik ohraničujúci 

oblasť, z ktorej sa vyberú body.  

https://docs.qgis.org/testing/en/docs/user_manual/print_composer/composer_items/composer_map.html#layout-map-item
https://docs.qgis.org/testing/en/docs/user_manual/map_views/map_view.html#sec-bookmarks
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• Do políčka priamo zadať súradnice priestorového ohraničenia v tvare xmin, xmax, 

ymin, ymax. 

• Thinned (by decimation) – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať 

názov, formát (LAS, LAZ, VPC) a umiestnenie výstupného súboru. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorená vrstva 

mračna bodov otvorí v projekte. 

 

 
 

Vstupná vrstva mračna bodov pre triedu č. 2 Groud (terén): 
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Výsledná zriedená vrstva mračna bodov pre triedu č. 2 Groud (terén) s nastaveným parametrom 

Number of points to skip = 5: 

 
 

Výsledná zriedená vrstva mračna bodov pre triedu č. 2 Groud (terén) s nastaveným parametrom 

Number of points to skip = 10: 
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16. Zlúčenie mračien bodov do jedného súboru 
 

Na zlúčenie viacerých súborov mračien bodov do jedného súboru slúži nástroj Merge, ktorý sa 

nachádza v paneli Processing Toolbox → Point cloud data management: 

 
 

Po spustení tohto nástroja sa otvorí okno Point Cloud Data Management - Merge, kde treba 

vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layers – vybrať vstupné vrstvy mračien bodov. 
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• Filter expression – zadanie podmienky pre výber vybranej podmnožiny bodov z mračna 

bodov (napr. vybrané triedy klasifikácie) (voliteľný parameter). 

• Cropping extent – zadanie priestorového rozsahu pre výber podmnožiny bodov z mračna 

bodov (voliteľný parameter). Dostupné metódy: 

• Calculate from Layer - použije sa priestorový rozsah (bounding box - BBOX) vrstvy 

načítanej v aktuálnom projekte. 

• Calculate from Layout Map - použije sa priestorový rozsah nastavený v uloženom 

mapovom projekte pre tlač (layout map item). 

• Calculate from Bookmark - použije sa priestorový rozsah z uloženej záložky 

nastaveného obsahu mapového okna (bookmark). 

• Use Current Map Canvas Extent - použije sa nastavený priestorový rozsah 

mapového okna. 

• Draw on Map Canvas - kliknúť do mapového okna a nakresliť obdĺžnik ohraničujúci 

oblasť, z ktorej sa vyberú body.  

• Do políčka priamo zadať súradnice priestorového ohraničenia v tvare xmin, xmax, 

ymin, ymax. 

• Merged – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov, formát (LAS, 

LAZ, VPC) a umiestnenie výstupného súboru. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorená vrstva 

mračna bodov otvorí v projekte. 

 

 
 

 

 

https://docs.qgis.org/testing/en/docs/user_manual/print_composer/composer_items/composer_map.html#layout-map-item
https://docs.qgis.org/testing/en/docs/user_manual/map_views/map_view.html#sec-bookmarks


77 
 

Vstupné vrstvy mračien bodov: 

 
 

Výstupný súbor mračna bodov po zlúčení: 
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17. Vytvorenie výrezu 
 

Na vytvorenie výrezu z vrstvy mračna bodov podľa zvoleného vektorového polygónu slúži nástroj 

Clip, ktorý sa nachádza v paneli Processing Toolbox → Point cloud data management: 

 
Po spustení tohto nástroja sa otvorí okno Point Cloud Data Management - Clip, kde treba vyplniť 

požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Clipping polygons – polygónová vrstva, podľa ktorej sa bude robiť výrez.  

• Filter expression – zadanie podmienky pre výber vybranej podmnožiny bodov z mračna 

bodov (napr. vybrané triedy klasifikácie) (voliteľný parameter). 

• Clipped – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov, formát (LAS, 

LAZ, VPC) a umiestnenie výstupného súboru. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorená vrstva 

mračna bodov otvorí v projekte. 
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Vstupná vrstva mračna bodov a polygón (fialová farba), podľa ktorého sa bude robiť výrez: 
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Výsledná vrstva mračna bodov po orezaní podľa hraníc polygónu: 

 
 

18. Vytvorenie dlaždíc 

 
Ak dáta mračien bodov nie sú distribuovaná priamo vo forme dlaždíc, ale napr. ako letové 

skenovacie pásy (footprints) s množstvom prekrytov medzi súbormi (ako napr. mračná bodov 

poskytované ÚGKK SR), tak sa vo všeobecnosti odporúča v prípade takýchto vrstiev mračien bodov 

najprv z nich vytvoriť dlaždice pre dosiahnutie najlepšieho výkonu pre ich ďalšie zobrazenie a 

analýzu. 

Na vytvorenie dlaždíc zo vstupných súborov mračien bodov slúži nástroj Tile. Výstupom z tohto 

nástroja je množina súborov mračien bodov, ktorá vznikne rozdelením vstupných vrstiev mračien 

bodov podľa zadefinovanej dlaždicovej schémy. 

Pred vytvorením dlaždíc treba skontrolovať či vrstvy mračna bodov majú správne zadefinovaný 

súradnicový systém. Ak nie, tak pre nastavenie súradnicového systému použiť nástroj Assign 

projection (1. kapitola). 

Nástroj Tile sa nachádza v paneli Processing Toolbox  → Point cloud data management: 
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Po spustení tohto nástroja sa otvorí okno Point Cloud Data Management - Tile, kde treba vyplniť 

požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layers – vybrať vstupné vrstvy mračien bodov. 

 
• Tile lenght – zadať dĺžku strany dlaždice. 

• Output directory – po kliknutí na tlačidlo  vybrať možnosť Save to Directory a zadať 

výstupný priečinok, kde sa vytvorené dlaždice uložia. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorené dlaždice 

otvoria v projekte. 
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Vstupné LAS súbory mračien bodov: 

 
 

Priečinok s vytvorenými dlaždicami: 

 
 

Súbory sú označené číslom stĺpca a riadka (stĺpec-riadok) vo vytvorenej dlaždicovej schéme. 

Číslovanie stĺpcov je v smeru od západu na východ a číslovanie riadkov je v smere od juhu na 

sever. 
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Zobrazenie rozloženia vytvorených dlaždíc pri pridávaní do projektu: 

 
 

Načítané dlaždice mračien bodov v projekte: 

 
 

19. Vytvorenie COPC (Cloud Optimized Point Cloud) indexových súborov 
 

Pre rýchlejšiu a jednoduchšiu prácu so súbormi mračien bodov vo formáte LAS a LAZ aplikácia QGIS 

pri načítavaní do projektu vytvára tzv. COPC (Cloud Optimized Point Cloud) indexové súbory, ktoré 

sa automaticky vytvoria v priečinku s načítavanými súbormi mračien bodov a sú označené ako 

.cop.laz. Vytvorené súbory COPC majú tiež určitú veľkosť vzhľadom na veľkosť zdrojových súborov, 

takže treba počítať, že tiež zaberú miesto z diskového priestoru počítača. 

Keď sa do projektu načítava viacero objemovo väčších neindexované vrstiev mračien bodov, 

aplikácii chvíľu potrvá, kým vytvorí index COPC pre tieto súbory. V takomto prípade je výhodné pre 

vytvorenie indexovaných COPC súborov použiť nástroj Create COPC, ktorý sa nachádza v paneli 

Processing Toolbox → Point cloud data management: 
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Po spustení tohto nástroja sa otvorí okno Point Cloud Data Management – Create COPC, kde treba 

vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layers – vybrať vstupné súbory mračien bodov uložené pomocou tlačidla Add File(s) 

alebo Add Directory pre automatické načítanie všetkých súborov z daného priečinka 

a potom kliknúť na tlačidlo OK: 

 

• Output directory – po kliknutí na tlačidlo  vybrať možnosť Save to Directory a zadať 

výstupný priečinok, kde sa vytvorené indexové COPC súbory vytvoria. Ak sa toto políčko 

nechá nevyplnené, tak sa CPC súbory vytvoria v priečinku so vstupnými súbormi mračien 

bodov. 
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Priečinok so vstupnými LAS súbormi mračien bodov a k nim vytvorenými COPC súbormi: 

 



86 
 

Po vytvorení COPC indexových súborov je možné súbory LAS alebo LAZ jednoducho a rýchlo 

načítať do projektu. 

Do projektu je možné pridať namiesto zdrojových LAS či LAS súborov aj vytvorené COPC súbory: 

 
 

Pridaným vrstvám COPC súborov potom treba ešte skontrolovať a nastaviť správny súradnicový 

systém podľa postupu uvedeného v 1. kapitole. 

 
 

20. Vytvorenie vrstvy mračna bodov vo formáte VPC (Virtual Point Cloud) 
 

Pre prácu s objemovo a priestorovo väčšími vrstvami mračien bodov je výhodné je použiť mračno 

bodov vo formáte VPC (Virtual Point Cloud), ktorý umožňujú spojiť a pracovať naraz s takýmito 

vrstvami mračien bodov bez nutnosti ich zlúčenia do jedného veľkého súboru alebo ich rozdelenia 

na dlaždice. 

Súbor VPC je v podstate jednoduchý súbor JSON s príponou .vpc, ktorý obsahuje odkazy na skutočné 
dátové súbory (napr. súbory .LAS, .LAZ alebo .COPC) a ďalšie metadáta extrahované zo súborov. 
Softvéry a nástroje podporujúce prácu s VPC súbormi potom spracovávajú celú množinu údajov 
zdrojových súborov mračien bodov ako jedinú vrstvu. 
Pred vytvorením dlaždíc treba skontrolovať či vrstvy mračna bodov majú správne zadefinovaný 

súradnicový systém. Ak nie, tak pre nastavenie súradnicového systému použiť nástroj Assign 

projection (1. kapitola). 

Na vytvorenie vrstvy mračna bodov vo formáte VPC slúži nástroj Build virtual point cloud (VPC), ktorý 

sa nachádza v paneli Processing Toolbox → Point cloud data management: 
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Po spustení tohto nástroja sa otvorí okno Point Cloud Data Management – Build Virtual Point Cloud 

(VPC), kde treba vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layers – vybrať vstupné vrstvy mračien bodov uložené a potom kliknúť na tlačidlo OK: 

 
• Calculate boundaty polygons – po označení políčka sa zobrazia presné hranice vrstiev 

namiesto len ich pravouhlého priestorového ohraničenia (BBOX). 

• Calculate statistics – označenie políčka pomôže aplikácii lepšie pochopiť rozsahy hodnôt 

rôznych atribútov vstupných vrstiev mračien bodov. 

• Build overview point cloud – po označení políčka sa vygeneruje jedna zjednodušená 

„prehľadová“ vrstva mračna bodov vo forme COPC súboru, ktorá sa uloží v priečinku vedľa 

súboru VPC. 
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• Virtual point cloud – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov, 

formát (VPC files) a umiestnenie výstupného súboru. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorená vrstva 

mračna bodov vo formáte VPC otvorí v projekte. 

 

 
 

Vstupné vrstvy mračien bodov: 
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Výsledná vrstva vo formáte VPC: 

 
 

Ak vstupné vrstvy mračien bodov pre vytvorenie VPC nie sú súbory vo formáte COPC, tak QGIS v 

súčasnosti zobrazí iba ich hranice v 2D a 3D zobrazeniach. Nástroje pre spracovanie VPC súborov ale 

budú fungovať. Ak je potrebné v projekte vo vrstve VPC zobraziť priamo body z vrstiev mračien 

bodov, tak je potrebné pre vytvorenie VPC použiť COPC indexové súbory. Ako COPC súbory vytvoriť, 

je uvedené v 19. kapitole. 

 

VPC pracuje aj so vstupnými vrstvami mračien bodov, ktoré nie sú dlaždicové napríklad v prípadoch, 

ak sú dáta distribuované ako letové skenovacie pásy (footprints) s množstvom prekrytov medzi 

súbormi (ako napr. mračná bodov poskytované ÚGKK SR). Aj keď  QGIS zvláda dobre prácu aj 

s takýmito vrstvami mračien bodov, tak sa vo všeobecnosti odporúča v prípade takýchto vrstiev 

mračien bodov najprv z nich vytvoriť dlaždice pomocou nástroja Tile (18. kapitola) pre dosiahnutie 

najlepšieho výkonu pre ich ďalšie zobrazenie a analýzu. 
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21. Vytvorenie rastra z mračna bodov metódou IDW 
 

Nástroj Export to raster exportuje dáta mračna bodov do 2D rastrovej mriežky, pričom bunkám 

rastra zapisuje hodnoty podľa zvoleného atribútu pomocou interpolačnej metódy použitá IDW 

(inverse distance weighting). Tento nástroj sa nachádza v paneli Processing Toolbox → Point cloud 

conversion: 

 
 

Po spustení nástroja Export to raster sa otvorí okno Point Cloud Conversion - Export to Raster, kde 

treba vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Attribute – vybrať atribút, podľa ktorého hodnôt sa raster vytvorí. 

• Resolution of the density raster – zadať hodnotu veľkosti bunky výstupného rastra. 

• Filter expression – zadanie podmienky pre výber vybranej podmnožiny bodov z mračna 

bodov (napr. vybrané triedy klasifikácie) (voliteľný parameter). 

• Cropping extent – zadanie priestorového rozsahu pre výber podmnožiny bodov z mračna 

bodov (voliteľný parameter). Dostupné metódy: 

▪ Calculate from Layer - použije sa priestorový rozsah (bounding box - BBOX)  vrstvy 

načítanej v aktuálnom projekte. 

▪ Calculate from Layout Map - použije sa priestorový rozsah nastavený v uloženom 

mapovom projekte pre tlač (layout map item). 

▪ Calculate from Bookmark - použije sa priestorový rozsah z uloženej záložky 

nastaveného obsahu mapového okna (bookmark). 

▪ Use Current Map Canvas Extent - použije sa nastavený priestorový rozsah mapového 

okna. 

▪ Draw on Map Canvas - kliknúť do mapového okna a nakresliť obdĺžnik ohraničujúci 

oblasť, z ktorej sa vyberú body.  

https://docs.qgis.org/testing/en/docs/user_manual/print_composer/composer_items/composer_map.html#layout-map-item
https://docs.qgis.org/testing/en/docs/user_manual/map_views/map_view.html#sec-bookmarks
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▪ Do políčka priamo zadať súradnice priestorového ohraničenia v tvare xmin, xmax, 

ymin, ymax. 

• Exported – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov 

a umiestnenie výstupného rastra vo formáte GeoTIFF. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorená rastrová 

vrstva otvorí v projekte. 

 

Ak je potrebné vytvoriť raster z viacerých LAS alebo LAZ súborov mračna bodov, tak ich treba najprv 

spojiť do jedného súboru pomocou nástroja Merge (16. kapitola) alebo v prípade mračna bodov 

z väčšieho územia z nich vytvoriť dlaždice pomocou nástroja Tile (18. kapitola). Potom pre každú 

vytvorenú dlaždice vyexportovať raster a nakoniec všetky rastre spojiť pomocou nástroja Merge, 

ktorý sa nachádza v paneli Raster → Miscellaneous (viac informácií v Návode na prácu s DMR v QGIS 

v kapitole č. 24 Spojenie rastrov DMR).  

Výhodné je použiť mračno bodov vo formáte VPC (Virtual Point Cloud), ktorý umožňuje prácu 

s objemovo a priestorovo väčšími súbormi mračien bodov bez nutnosti ich zlúčenia do jedného 

veľkého súboru alebo rozdelenia na dlaždice. Postup ako vytvoriť vrstvu mračna bodov vo formáte 

VPC je uvedený v 20. kapitole. 

 

Nástroj Export to raster je možné použiť napr. na tvorbu digitálneho modelu reliéfu (DMR) alebo 

rastra plochy vegetácie. Na tvorbu digitálneho modelu povrchu (DMP) tento nástroj nie je príliš 

vhodný vzhľadom na použitú interpolačnú metódu, ktorá interpoluje výšky objektov ako napr. 

elektrické vedenia, vyššie budovy či vegetácia vzhľadom na okolité body z mračna bodov, takže ich 

výška vo vytvorenom DMP potom nemusí úplne zodpovedať skutočnosti. 

 

Raster DMR 

Pre vytvorenie rastra digitálneho modelu reliéfu (terénu) podľa hodnôt atribútu Z (výška bodov) len 

z bodov triedy č. 2 Ground (terén) treba v nástroji Export to raster v políčku Attribute vybrať atribút 

Z a do políčka Filter expression zadať podmienku Classification = 2: 

https://www.geoportal.sk/files/zbgis/lls/navod-pracu-dmr-qgis.pdf
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Vstupná vrstva mračna bodov – body z triedy č. 2 Ground (terén): 
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Vytvorený raster DMR: 

 
 

V oblastiach, kde nebolo naskenované mračno bodov (napr. vodné plochy, plochy pod budovami a 

vegetáciou) vzniknú po vyexportovaní rastra prázdne miesta (diery) a rastrové bunky v týchto 

miestach získajú hodnoty „NoData“. 

Tieto diery v rastri možno odstrániť použitím nástroja Fill NoData, ktorý doplní hodnoty pre 

prázdne bunky rastra interpoláciou z okolitých hodnôt buniek pomocou metódy IDW (inverse 

distance weighting). 

 

Nástroj Fill NoData sa nachádza v paneli Raster → Analysis: 
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Po spustení nástroja treba vyplniť požadované parametre a kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupný raster. 

• Band number – vybrať pásmo rastra, na ktorom sa algoritmus na úpravu hodnôt NoData 

spustí.  

• Maximum distance (in pixels) to search out for values to interpolate – zadať maximálnu 

vzdialenosť (v pixeloch) na vyhľadanie platných pixelov, ktoré budú použité pri interpolácii 

→ pre automatický výpočet polomeru vyhľadávania zadať hodnotu 0. 

• Number of smoothing iterations to run after the interpolation – zadať počet iterácií 

vyhladzovania výsledkov interpolácie. 

• Filled – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov, formát a 

umiestnenie výstupného súboru. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorený raster 

otvorí v projekte. 
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Vytvorený raster DMR bez dier pomocou nástroja Fill NoData: 

 
 

Ako posledný krok je potrebné raster DMR bez dier vytvorený pomocou nástroja Fill NoData ešte 

orezať presne podľa priestorového rozsahu zdrojového mračna bodov použitého na vytvorenie 

DMR, aby bola zachovaná pôvodná plocha územia podľa vstupného mračna bodov bez skreslených 

okrajových hodnôt rastra DMR doplnených interpoláciou. 

Porovnanie priestorového rozsahu vrstvy zdrojového mračna bodov a vytvoreného rastra DMR bez 

dier pomocou nástroja Fill NoData: 

 
 

Raster DMR je možné orezať pomocou polygónu hranice vrstvy mračna bodov, vytvoreného 

pomocou nástroja Boundary (14. kapitola), alebo podľa zvolenej vektorovej polygónovej vrstvy, 

podľa ktorej bolo na začiatku mračno bodov orezané.  
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Polygón hranice vrstvy mračna bodov, vytvoreného pomocou nástroja Boundary: 

 
 

V polygónovej vrstve je ešte potrebné odstrániť dier na miestach, kde neboli dostupné žiadne 

body mračna bodov. Je na to možné použiť nástroj Delete holes, ktorý sa nachádza v paneli 

Processing Toolbox → Vector geometry: 

 
 

Po spustení toho nástroja sa objaví okno, kde treba vyplniť požadované parametre a potom 

kliknúť na tlačidlo Run: 

• Input layer - vybrať vstupnú polygónovú vrstvu, z ktorej treba odstrániť diery. 

• Remmove holes with area less than – podľa zadanej hodnoty sa odstránia iba diery s 

plochou menšou ako táto zadaná hodnota. Pri hodnote 0,0 sa odstránia všetky diery. 

• Cleaned - zvoliť možnosť Save to File... a zadať názov, formát, umiestnenie výstupnej 

polygónovej vrstvy. 
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Polygón hranice vrstvy mračna bodov po odstránení dier: 

 
 

Na orezanie rastra DMR podľa polygónovej vrstvy je možné použiť nástroj Clip raster by mask 

layer, ktorý sa nachádza v paneli Raster → Extraction. Po spustení toho nástroja sa objaví okno, 

kde treba vyplniť požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer - vybrať vstupný DMR. 

• Mask layer - vybrať vektorovú vrstvu, podľa ktorej sa vytvorí výrez z DMR. 

• Source CRS – vybrať súradnicový systém vstupného rastra. 

• Target CRS – vybrať súradnicový systém výstupného rastra. 

• Match the extent of the clipped raster to the extent of the mask layer – označiť políčko. 

• Clipped (mask) - zvoliť možnosť Save to File... a zadať názov, formát, umiestnenie 

výstupného rastra. 
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Finálny raster DMR po orezaní podľa polygónu hranice zdrojovej vrstvy mračna bodov: 
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Porovnanie s priestorovým rozsahom vrstvy zdrojového mračna bodov: 

 

 

Raster plochy vegetácie 

Pre vytvorenie rastra plochy vegetácie pre triedy č. 3 Low Vegetation (nízka vegetácia), 4 Medium 

Vegetation (stredná vegetácia) a 5 High Vegetation (vysoká vegetácia) treba v nástroji Export to 

raster v políčku Attribute vybrať atribút Classification a do políčka Filter expression zadať podmienku 

Classification = 3 OR Classification = 4 OR Classification = 5: 
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Vstupná vrstva mračna bodov – body z tried vegetácie: 

 

Výsledný raster zobrazujúci plochu pokrytú triedami vegetácie z mračna bodov v priestorovom 

rozlíšení 0,5 m: 
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Raster intenzity 

Pre vytvorenie rastra, zobrazujúceho priebeh hodnôt atribútu intenzita odrazeného laserového lúča 

treba v nástroji Export to raster v políčku Attribute vybrať atribút Intensity: 

 

Vstupná vrstva mračna bodov s nastavenou symbolikou podľa atribútu Intensity: 
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Výsledný raster zobrazujúci priebeh hodnôt atribútu intenzita: 

 
 

21. Vytvorenie rastra z mračna bodov metódou TIN 
 

Nástroj Export to raster (using triangulation) exportuje dáta mračna bodov do 2D rastrovej mriežky 

pomocou triangulácie bodov použitím interpolačnej metódy TIN (Triangulated Irregular Network). 

Na výstupe je možné získať napr. digitálny model reliéfu (DMR). Tento nástroj sa nachádza v paneli 

Processing Toolbox → Point cloud conversion: 

 
 

Po spustení tohto nástroja sa otvorí okno Point Cloud Conversion - Export to Raster, kde treba vyplniť 

požadované parametre a potom kliknúť na tlačidlo Run: 

• Input layer – vybrať vstupnú vrstvu mračna bodov. 

• Resolution of the density raster – zadať hodnotu veľkosti bunky výstupného rastra. 

• Filter expression – zadanie podmienky pre výber vybranej podmnožiny bodov z mračna 

bodov (napr. vybrané triedy klasifikácie) (voliteľný parameter). 
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• Cropping extent – zadanie priestorového rozsahu pre výber podmnožiny bodov z mračna 

bodov (voliteľný parameter). Dostupné metódy: 

• Calculate from Layer - použije sa priestorový rozsah (bounding box - BBOX)  vrstvy 

načítanej v aktuálnom projekte. 

• Calculate from Layout Map - použije sa priestorový rozsah nastavený v uloženom 

mapovom projekte pre tlač (layout map item). 

• Calculate from Bookmark - použije sa priestorový rozsah z uloženej záložky 

nastaveného obsahu mapového okna (bookmark). 

• Use Current Map Canvas Extent - použije sa nastavený priestorový rozsah mapového 

okna. 

• Draw on Map Canvas - kliknúť do mapového okna a nakresliť obdĺžnik ohraničujúci 

oblasť, z ktorej sa vyberú body.  

• Do políčka priamo zadať súradnice priestorového ohraničenia v tvare xmin, xmax, 

ymin, ymax. 

• Exported – po kliknutí na tlačidlo  vybrať možnosť Save to File a zadať názov 

a umiestnenie výstupného rastra vo formáte GeoTIFF. 

• Open output file after running algorithm – po označení tohto políčka sa vytvorená rastrová 

vrstva otvorí v projekte. 

 

Ak je potrebné vytvoriť raster z viacerých LAS alebo LAZ súborov mračna bodov, tak ich treba najprv 

spojiť do jedného súboru pomocou nástroja Merge (16. kapitola) alebo v prípade mračna bodov 

z väčšieho územia z nich vytvoriť dlaždice pomocou nástroja Tile (18. kapitola). Potom pre každú 

vytvorenú dlaždice vyexportovať raster a nakoniec všetky rastre spojiť pomocou nástroja Merge, 

ktorý sa nachádza v paneli Raster → Miscellaneous (viac informácií v Návode na prácu s DMR v QGIS 

v kapitole č. 24 Spojenie rastrov DMR).  

Výhodné je použiť mračno bodov vo formáte VPC (Virtual Point Cloud), ktorý umožňuje prácu 

s objemovo a priestorovo väčšími súbormi mračien bodov bez nutnosti ich zlúčenia do jedného 

veľkého súboru alebo rozdelenia na dlaždice. Postup ako vytvoriť vrstvu mračna bodov vo formáte 

VPC je uvedený v 20. kapitole. 

 
 

Raster DMR 

Pre vytvorenie rastra digitálneho modelu reliéfu (terénu) podľa hodnôt atribútu Z (výška bodov) len 

z bodov triedy č. 2 Ground (terén) treba v nástroji Export to raster (using triangulation) do políčka 

Filter expression zadať podmienku Classification = 2: 

https://docs.qgis.org/testing/en/docs/user_manual/print_composer/composer_items/composer_map.html#layout-map-item
https://docs.qgis.org/testing/en/docs/user_manual/map_views/map_view.html#sec-bookmarks
https://www.geoportal.sk/files/zbgis/lls/navod-pracu-dmr-qgis.pdf
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Vstupná vrstva mračna bodov – body z triedy č. 2 Ground (terén): 
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Vytvorený raster DMR: 

 


